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1 Introduction 

The Firm Yield Estimator - Version 1.0 (FYE) is a software tool for use in estimating the firm 
yield of Massachusetts surface water reservoir systems. The software is designed to assist 
communities in fulfilling the requirements of the Massachusetts Water Management Act which 
requires communities permitting surface water supplies to demonstrate the ability to meet their 
projected demand by estimating the firm yield of the reservoir system based on the 1960's 
drought-of-record. The algorithms employed by the software are those recommended by the 
Massachusetts Department of Environmental Protection (DEP) in its January 1996 Guidance 
Document entitled “Estimating the Firm Yield of a Surface Water Reservoir Supply System in 
Massachusetts” (DEP, 1996). 

The program is menu-driven, and help files are available to lead the user through the appropriate 
steps to develop an estimate for the firm yield of a surface water reservoir or a system of surface 
water reservoirs. The program assists the user in performing a reservoir yield scanning analysis 
to determine whether synthetically generated precipitation and streamflow data are necessary for 
the firm yield assessment. If any reservoir in the system does not refill at any point during at 
least 15% of the years examined in the scanning analysis, the program will generate the 1,000­
year sequence of precipitation and streamflow data that is required for the firm yield assessment. 

After performing the scanning analysis, the user can then perform the firm yield analysis using 
either actual meteorological and streamflow data or the synthetic data developed in the scanning 
analysis. The program is linked to a database of temperature, precipitation, and snowfall data 
from meteorological stations in Massachusetts (as well as some bordering locations in Rhode 
Island, Connecticut, New York, Vermont, and New Hampshire). The program is also linked to a 
database of U.S.G.S. (United States Geological Survey) streamgauge data for sites across 
Massachusetts. The user has the option of selecting a meteorological station and streamgauge 
location from the databases or supplying his or her own data. Additional information about the 
reservoir system (such as required releases from the reservoir, peak use factors, withdrawals by 
other users, watershed elevation, soil retention, channel slope factors, etc.) are entered by the 
user in standard Windows dialog boxes or through input files specified in such dialog boxes. 
The user can also specify the relationship between the area of the reservoir and the volume of 
water in the reservoir. 

The software is capable of producing output in a form that partially satisfies the requirements of 
materials that must be submitted to DEP in support of a reservoir system yield assessment. The 
program can produce plots (both on-screen and hard-copy) of the reservoir storage vs. time. The 
program is also capable of producing summary files of the data used in the firm yield analysis. 
These files identify the options that were selected and the meteorological and streamflow data 
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that were used in the firm yield analysis. The software can also produce data files containing a 
table of reservoir storage versus time. 

The software includes helpfiles that contain all of the information presented in Chapter 2 of this 
software documentation and training manual. Using only the help files, users can develop firm 
yield estimates in the absence of this training manual. 
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2 Technical documentation 

2.1 Installation 

The FYE is designed to run on any computer running Microsoft’s Windows 95, Windows 98, or 
Windows 2000. The FYE is installed by simply copying the file FirmYld.exe from the CD-ROM 
to a directory on the hard drive. If desired, a shortcut to the FYE can be placed on the desktop 
using Windows Explorer. To start the program, double click the file in Windows Explorer, or 
select Run from the Windows Start menu and enter the filename. 

The remaining directories on the CD-ROM contain the meteorological and streamflow databases. 
These files can either be copied to the hard drive, or they can be accessed directly from the CD­
ROM. 

2.2 Program startup 

Upon initial startup, the FYE will display a title screen with a menu across the top of the 
program window and three buttons at the bottom, labeled Continue, Close, and Credits. All 
menu options are inactive while the title screen is displayed with the exception of the Exit option 
on the File menu and the Help options. Selecting File|Exit will close the FYE.  Selecting Help 
will activate the Windows Help for the FYE and will allow the user to search the electronic 
version of the FYE’s documentation. 

Clicking on the Continue button erases the title screen, activates many of the menu options, and 
displays key information about the reservoir system being analyzed. The top section of the 
screen summarizes the meteorological data that are currently being used in the analysis including 
the name of the meteorological station used in the analysis, the years of meteorological data 
used, and the completeness of the meteorological data set. The next section summarizes 
streamflow data including the name of the stream gauge used in the analysis and the years of 
streamflow data that are used. The third section summarizes reservoir-specific data that have 
been entered by the user, showing whether reservoir characteristics, bathymetry data, 
withdrawals by other users, peak use factors, and evaporation rates have been specified. 
Initially, the screen display will indicate only that no information has been entered. The bottom 
section of the screen summarizes (in bold type) which analyses have been performed for the 
reservoir. If a firm yield analysis has already been performed for the reservoir system, the 
estimated firm yield of the reservoir will appear in this section. 

Clicking on the Close button closes the FYE program. This performs the same action as 
selecting Exit from the File menu or clicking the close button in the top right corner of the 
program window. 
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Clicking on the Credits button displays a dialog box containing information about the software 
developer, database developer, and a photo credit for the image on the title screen. Click the Ok 
button to close the dialog box and return to the title screen. 

2.3 File management 

File management in the FYE is controlled through use of the File menu. After the Continue 
button is pressed on the title screen, the title screen is erased, and all of the options on the File 
menu are activated. Three menu items relate to file management, Open, Close, and Save. A 
fourth option, Summary File, saves a file summarizing the firm yield analysis. The fifth option, 
at the bottom of the File menu is Exit. 

Selecting File|Open brings up a standard Windows dialog box for opening files. Select a 
previously created FYE file from this dialog box to modify or review an analysis. The default 
extension for files is .fye, and files with this extension in the current directory will automatically 
be listed in the open file dialog box. To list all files with any extension in this dialog box, select 
“All Files (*.*)” from the list box at the bottom of the dialog box, then click Open. Only one 
reservoir can be analyzed at a time. (Analysis of a system of reservoirs is handled with the 
options in the System menu.) Hence, if a new file is opened while an analysis for a second 
reservoir system is being performed, the FYE will display a warning message if the analysis for 
the second reservoir system has not been saved. The warning message gives the user the option 
of saving the existing analysis prior to opening the file, erasing the existing analysis prior to 
opening the file, or canceling the operation. 

File|Close closes the existing analysis and erases all input data. File|Close does not save the 
analysis. To save a firm yield analysis, select File|Save. 

File|Save opens a standard Windows dialog box for saving files. Specify the directory in which 
the file should be saved and the filename, then click the Save button. The default filename 
extension for firm yield analyses is .fye. Select the Cancel button to return to the FYE without 
saving the data file. After clicking the Save button, the FYE displays a dialog box that allows the 
user to specify a title for the analysis and any comments that the user wishes to include in the 
data file. After entering the title and comments, click the Ok button to save the data file. 

File|Summary file opens a standard Windows dialog box for saving files. This option is disabled 
if a firm yield has not yet been calculated for the reservoir or if the user changes input data 
without recalculating the firm yield of the reservoir.  Specify the directory in which the file 
should be saved and the filename, then click the Save button. The default file type for the 
summary file is a Text file with a filename extension of .txt. Select the Cancel button to return to 
the FYE without saving a summary file. Appendix C contains a sample summary file from the 
FYE. 

File|Exit closes the FYE. This performs the same action as selecting the standard Windows 
close button marked with an x in the top right corner of the program window. 
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2.4 Accessing meteorological and streamflow databases 

Accessing meteorological data and streamflow data from the databases that accompany the FYE 
is done through the Data menu. The topmost section of the Data menu contains three options 
pertaining to meteorological data. The second section contains three options that allow access to 
streamflow data. 

2.4.1 Meteorological data 

The Data|Preprocess NOAA data option is used to update the databases that accompany the 
FYE. Selecting this option allows the user to start with the ASCII Cooperative Summary of the 
Day TD3200 (Tape Deck 3200) data files obtainable from the National Climatic Data Center 
(NCDC) of the National Oceanic and Atmospheric Administration (NOAA) and process 
meteorological data into a format that can easily be read by the FYE. Data in TD3200 format 
can be purchased from NOAA on CD-ROM. Daily meteorological data available for all 
meteorological stations in a state are in a single data file. These data include air and soil 
temperatures, rainfall, snowfall, and evaporation. A detailed description of this data format can 
be obtained from NOAA upon request. 

After selecting the Preprocess NOAA data option, an open file dialog box will appear on the 
screen. Select the meteorological data file that contains data on the stations of interest. Because 
NOAA’s default file extension for TD3200 meteorological data files is .dat, this is the default 
extension in the open file dialog box. After selecting the data file, a select directory dialog box 
will appear. Specify the drive on which the preprocessed meteorological files will be saved, and 
then select the directory in which the files will be saved by double-clicking on the appropriate 
directory (the file folder icon next to the directory in which the files will be saved will show an 
open file folder). Click Ok to begin preprocessing the meteorological data. 

On the CD-ROMs containing the NOAA meteorological data, in addition to the meteorological 
data file, NOAA provides a station inventory file (file extension .inv). The inventory file 
contains station names and specifies which data were collected at each station during each year. 
The inventory file is not necessary for the FYE to preprocess meteorological data, but because 
the data file itself identifies meteorological stations by number and not by name, the FYE will 
not have access to the station names if the inventory file is not available. The FYE searches for 
the inventory file in the same directory in which the meteorological data file is located. If the 
inventory file is located by the FYE, meteorological station names will be added to the 
preprocessed meteorological data files; otherwise, the station name in the preprocessed files will 
be a blank line. On the June 1995 CD-ROM for New England meteorological stations (NOAA, 
1995a), the data file for Massachusetts is named MA19STN.DAT and the inventory file is named 
MA19STN.INV. 

Preprocessing meteorological stations for a state could take several minutes for states with large 
numbers of meteorological stations (the meteorological file for New York contains data for 
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several hundred meteorological stations and is 307 MB in size). The FYE will not allow the user 
to access any of the menu items until meteorological data preprocessing is complete. The FYE 
will save one file for each meteorological data station in the specified directory. The filename 
for each meteorological data file consists of the station number for the meteorological station 
followed by the extension .met. For example, the filename for the preprocessed meteorological 
data file for Boston’s Logan International Airport (station number 190770) is 190770.met. 

The meteorological data files included with the FYE as the meteorological database are 
preprocessed data files. See Chapter 4 for a detailed description of the meteorological database. 
Appendix A contains a sample of a preprocessed meteorological data file. 

Data|Input meteorological data allows the user to specify the name of a file containing 
preprocessed meteorological data for use in the firm yield analysis. After selecting this option, 
an open file dialog box will appear. The default file extension for preprocessed meteorological 
files is .met. Select the appropriate file and click Open. After opening the file, the 
meteorological station name, years for which meteorological data are available, and the 
completeness of the meteorological data set will be displayed in the main window of the FYE. 

Data|Select met file from list allows the user to select a meteorological station from a list of 
stations by name. A select directory dialog box will appear asking the user to specify a directory 
containing preprocessed meteorological data files. The FYE will then search the directory for all 
files with the .met extension and will list the station names in a list box. Scroll down the list of 
meteorological stations and select the desired station, then click Ok. After opening the file, the 
meteorological station name, years for which meteorological data are available, and the 
completeness of the meteorological data set will be displayed in the main window of the FYE. 

After selecting a meteorological data file using either the Data|Input meteorological data or the 
Data|Select met file from list option, if complete temperature, precipitation, and snowfall data are 
not available for every month in the period of record, the FYE displays a dialog box asking the 
user how to accommodate missing data. The user is presented with four options for replacing 
missing data. The first option is to replace missing data with an average value for that month, 
calculated from all available data. If, for example, precipitation data are missing for February 
1968, the FYE will calculate the average precipitation for February in all other years, and use 
that value in place of the missing February 1968 value. Naturally, this option could not be used 
if precipitation data were missing for February of every month in the period of record. In this 
case, the FYE would prompt the user to select an alternate method for replacing missing data. 
The second option is to replace missing data with meteorological data from a nearby 
meteorological station. The FYE will prompt the user to enter a meteorological data station to 
use for replacement data. First, the FYE displays a dialog box asking the user to select the 
directory in which the meteorological data files are stored. The FYE then displays a dialog box 
listing all available meteorological stations in that directory. Select the desired meteorological 
station and click Ok. If all missing data cannot be replaced using the alternate data file, the FYE 
prompts the user to select another method (or simply another meteorological station) to use to 
replace data that are still missing. The third option is to replace missing data by interpolating 
between months that have data. This is most useful when only a few data points are missing, 
because interpolated data can be wildly inaccurate if, for example, all data were missing between 

2-4
 



February 1968 and February 1969, and the FYE interpolated temperature data for all missing 
months based on temperatures in February 1968 and February 1969.  The fourth, and final, 
option is to replace missing data by using the data from the previous year (or most recent year for 
which data are not missing). If February 1968 precipitation data are missing, the FYE replaces 
this value with the precipitation measured in February 1967. If data from the first year of the 
dataset are missing, the FYE instead uses data from the first subsequent year for which data are 
available. 

2.4.2 Streamflow data 

To estimate the firm yield of a surface water reservoir, one must know the surface water inflow 
to the reservoir. Ideally, one would have a stream gauge on the stream or river that feeds the 
reservoir; however, data from such a stream gauge seldom exist. In the absence of a stream 
gauge on the desired stream, it is desirable to identify a nearby unregulated stream or river and to 
use those data combined with information about the watersheds for both the gauged stream and 
the reservoir stream to estimated surface water inflow to the reservoir. The options discussed in 
this section allow the user to specify streamflow data that can be used to estimate inflow to the 
reservoir. 

Data|USGS streamflow data allows the user to specify a USGS streamflow data file to use for 
streamflow data in the firm yield analysis. Selecting this option brings up an open file dialog 
box. Select the directory containing the streamflow data files, select the appropriate file, and 
click Open. The default file extension for USGS streamflow files is .txt. The file format for the 
USGS data files is that in which they can be obtained directly from the USGS website 
(http://water.usgs.gov).  See Chapter for a detailed description of this file format and see for a 
sample streamflow data file. 

Data|Select USGS file from list is similar to the Data|Select met file from list option and allows 
the user to select a stream gauge location by name from a list of streamgauge locations.  Upon 
selecting this option, a select file dialog box will appear asking the user to select the directory in 
which the USGS data files are saved. Select a drive and double click on a directory to highlight 
it (the file folder icon should show an open folder) then click Ok. The FYE will search the 
directory for USGS data files with a .txt extension and will list the station names in a list box. 
Scroll down the list of streamflow stations and select the desired station, then click Ok. After 
opening the file, the stream gauge name and years for which streamflow data are available will 
be displayed in the main window of the FYE. 

Data|Other streamflow data is a means of entering streamflow data if data are not available in 
the USGS format. To use this option, the user must create a data file of streamflow data in a 
specified format. The file should use only ASCII characters. All blank lines and lines beginning 
with the pound sign “#” are treated as comments and are ignored by the FYE.  The first line of 
the file (other than comment lines) should be the name of the location where the streamflow 
measurements (or estimates) were made. Subsequent lines should contain a month (an integer 
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between 1 and 12), a year (all four digits), and the total monthly streamflow in units of millions 
of gallons per month. The first few lines of a sample data file could read: 

#This is a data file containing monthly streamflow 
#data for Aber’s Creek near the proposed reservoir 
#site. 
#Streamflow data are in units of millions of gallons 
#per month 
# 
Aber’s Creek 
1 1960 223 
2 1960 302 
3 1960 440 
4 1960 365 
5 1960 478 
6 1960 298 

etc. 

2.5 Entering reservoir-specific properties 

The five options at the bottom of the Data menu allow the user to enter reservoir-specific 
properties necessary for estimating the firm yield of the reservoir. These options can also be 
accessed by clicking on the blue hypertext links on the main screen of the FYE. The options are 
divided into two groups. The first contains only the Data|Reservoir characteristics menu item. 
The reservoir characteristics accessed by this selection (as well as a meteorological station and a 
stream gauge location) must be specified prior to transforming the streamflow data from the 
stream gauge into estimated inflows to the reservoir (using the Calculate|Transform USGS data 
option). The remaining four options (Data|Bathymetry, Data|Evaporation rates, Data|Peak use 
factors, and Data|Withdrawals by other users) must be specified prior to performing a scanning 
analysis (Calculate|Perform scanning analysis) or a firm yield analysis (Calculate|Estimate firm 
yield) of the surface water reservoir. On the main window of the FYE, the information under the 
heading “Other Data” allows the user to quickly determine which data have and have not been 
supplied. 

Selecting the Data|Reservoir characteristics option displays a dialog box on the screen that 
allows the user to enter the area of the watershed supplying the reservoir (in square miles), the 
area of the watershed contributing to streamflow at the stream gauge (also in square miles), and 
the usable capacity of the reservoir (in millions of gallons). Additionally, the dialog box asks the 
user to specify required release rates from the reservoir. 

Four radio buttons allow the user to select from four possibilities for specifying release rates. 
The four radio buttons are labeled No required releases, Constant release rate, Release rate 
varies by month of year, and Specify release rates in a text file. Selecting the No required 
release button automatically sets required releases equal to zero when estimating the firm yield 
of the reservoir. Selecting Constant release rate sets the required releases equal to the specified 

2-6
 



value for every month of the period used to calculate the firm yield. Selecting Release rate 
varies by month of year brings up a dialog box in which the user can specify required release 
rates for each month of the year. Specify the release rates by month and then click Ok to close 
the monthly release rate dialog box. Finally, selecting Specify release rates in a text file brings 
up an open file dialog box in which the release rate file can be specified. This option is useful if 
the required release rates change from year to year. The format of the release rate file is the 
similar to the format for Other streamflow data discussed in Section 2.4.2 above. Lines 
beginning with the pound sign (#) are treated as comments and are ignored. All other lines 
should begin with a month (an integer between 1 and 12), a four-digit year, and the required 
release rate in millions of gallons for the month. A sample of the first few lines of a release rate 
file appears below: 

#The first three lines of this file are comments 
#Release rates are given in millions of gallons per 
#month 
3 1955 57.8 
4 1955 80 
5 1955 30.4 
6 1955 57.8 
7 1955 28.6 
8 1955 40.2 
etc. 

The FYE performs a few checks on the data entered in the reservoir characteristics dialog box. 
The areas of the reservoir and stream gauge watersheds must both be greater than zero, but less 
than the total area of Massachusetts (7,838 square miles). The volume of the reservoir must be a 
positive number in millions of gallons. If a constant release rate is specified or if release rates 
are specified by month, all specified release rates must be between 0 and 100,000 million 
gallons. 

When the Data|Bathymetry option is selected, the FYE will display a dialog box in which the 
user can specify a polynomial that will be used to estimate the surface area of the reservoir as a 
function of the volume of usable water in the reservoir. DEP’s guidance document (DEP, 1996) 
recommends fitting a third order (or higher) polynomial to bathymetry data.  First, specify the 
order of the polynomial that will be used to estimate reservoir surface area from the volume of 
usable water in the reservoir. Then, enter the best-fit coefficients for the polynomial. The 
polynomial will be of the form: 

A = C + C1S + C2S 2 + C3S
3 + . . . 

where A is the surface area of the reservoir in square miles, and S is the usable volume of water 
in the reservoir in millions of gallons. The coefficients C, C1, C2, C3, etc. are the constant 
coefficient, linear coefficient, quadratic coefficient, cubic coefficient, etc. The polynomial 
cannot be of order greater than nine. Note that S is the volume of usable water in the reservoir, 
not the total volume of water in the reservoir. 
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Data|Evaporation rates allows the user to specify evaporation rates for the reservoir. Clicking 
on this menu item will create an evaporation rates dialog box. Two radio buttons at the top of 
the dialog box allow the user to select between specifying evaporation rates by month or 
estimating evaporation rates directly from meteorological data. If Specify monthly evaporation 
rates is selected, specify monthly evaporation rates in inches for each month in the bottom 
section of the dialog box. Each evaporation rate specified must be greater than or equal to zero. 
If Estimate evaporation from meteorological data is selected, evaporation rates will be estimated 
from the meteorological data. If this option is selected when no meteorological data have been 
entered, the FYE will display a warning message and will then ask the user to either specify 
monthly evaporation rates or to enter meteorological data before attempting to estimate 
evaporation rates. If meteorological data have already been entered, the FYE will prompt the 
user to enter the longitude of the reservoir (in decimal degrees) and the elevation of the reservoir 
(in feet). See Appendix 2: Estimating Reservoir Evaporation of the DEP guidance document 
(DEP, 1996) for a detailed description of the algorithm used to estimate reservoir evaporation 
from meteorological data. To view the evaporation rates that have been estimated, after 
specifying the longitude and elevation and clicking Ok, click on Data|Evaporation rates again. 
Estimate evaporation from meteorological data will remain selected, but the calculated 
evaporation rates will appear in the bottom section of the dialog box. 

Data|Peak use factors allows the user to enter peak use factors for withdrawing water from the 
reservoir. These values account for seasonal variations in withdrawal rates from the reservoir. 
Default values for the peak use factor are 0.7 for January through March, 0.9 for April, 1.2 for 
May, 1.4 for June, 1.5 for July, 1.3 for August, 1.1 for September, 0.9 for October, and 0.8 for 
November and December. These default peak use factors are those recommended by DEP 
(2000) for use in the firm yield analysis and describe a typical scenario in which summer 
withdrawal rates from the reservoir will be higher than average while winter withdrawal rates 
will be lower. The peak use factors must all be greater than or equal to zero, and the average of 
the twelve peak use factors should be 1.0. If the sum of the monthly peak use factors falls 
outside the range of 11.9 to 12.1, the FYE displays an error message and asks the user to correct 
the data. After specifying the peak use factors, click Ok to continue with the analysis. 

Data|Withdrawals by other users allows the user to enter withdrawal rates from the reservoir by 
other users of water. Selecting this menu item will display a dialog box very similar to the one 
for peak use factors. Specify monthly withdrawal rates in millions of gallons per day, then click 
Ok. All withdrawal rates should be greater than or equal to zero. By default, the withdrawal 
rates for other users for all months are zero, representing a scenario in which there are no other 
users of reservoir water. 

2.6 Estimating reservoir system yields 

The Calculate menu contains options that allow the user to perform a scanning analysis of a 
reservoir and estimate the firm yield of a surface water reservoir. Additional options allow the 
user to estimate surface water inflows to a surface water reservoir from daily streamflow data or 
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to generate 1,000 years of meteorological data using the bootstrapping technique described in 
DEP’s guidance (1996). 

2.6.1 Transform USGS data 

The first option on the Calculate menu is the Transform USGS data option. This option 
generates flow rates for a stream based on meteorological data, streamflow data for a nearby 
stream, and information about the reservoir and watersheds. Because the calculations are based 
on meteorological data, streamflow data, and reservoir characteristics, the Calculate|Transform 
USGS data menu item cannot be accessed until these data have been entered. Because inflow to 
the reservoir must be known before the firm yield of the reservoir can be estimated, the Perform 
scanning analysis, Generate meteorological data, and Estimate firm yield options on the 
Calculate menu remain inaccessible until the streamflow data are transformed. 

Upon selecting Transform USGS data, a dialog box will be displayed requesting information 
about the reservoir watershed. Enter the average watershed elevation (feet), the mean channel 
slope (feet/mile), and the maximum soil retention (inches) for the surface water reservoir. See 
Chapter 3 of the DEP guidance (1996) for a description of how to calculate the mean channel 
slope and the maximum soil retention. By default, the FYE will calculate average annual 
precipitation and average annual snowfall from the meteorological data, but if these do not 
represent a best estimate of precipitation in the vicinity of the reservoir, the user can select the 
appropriate radio buttons and specify values for average precipitation and snowfall. On the rare 
occasions when the stream gauge is located at the inflow to the reservoir, check the box labeled 
Streamgauge data can be used directly in the firm yield analysis and click Ok. In this case, it is 
not necessary to specify any additional information in the dialog box. 

The FYE performs minimal checking on the entries in the dialog box. The watershed elevation 
must be greater than 0 and less than 3,487 feet (the highest elevation in Massachusetts). The 
mean channel slope must be between 0 and 5,000 feet/mile, and the maximum soil retention 
must be between 0 and 100 inches. Average annual precipitation and snowfall must both be 
between 0 and 200 inches. 

After entering all data in the dialog box, the FYE will estimate inflows to the surface water 
reservoir. The algorithm used to calculate the inflows is the QPPQ transform described in detail 
in Chapter 3 of the DEP guidance (1996). After surface water inflows to the reservoir have been 
estimated, the text at the bottom of the FYE main window will indicate that the transform has 
been performed, and the options to perform a scanning analysis and to generate 1,000 years of 
meteorological data will be activated. 

2.6.2 Scanning analysis 

A scanning analysis generates a rough estimate of the reservoir firm yield by using several 
simplifying assumptions. The primary reason for performing the scanning analysis is to 
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determine whether the firm yield assessment requires the use of synthetically generated 
precipitation and streamflow data to supplement measured data.  DEP has determined that if a 
reservoir does not refill at least one month a year during 15% or more of the years in the 
scanning analysis period of record, a 1,000 year long sequence of streamflow and precipitation 
data is required in the firm yield assessment. The reason for this is to ensure that the firm yield 
analysis is performed using data from a sufficiently long period-of-record that includes the most 
important climate and streamflow sequences which occur during the very worst possible 
droughts. The assumed initial condition of a full reservoir at the start of the first month of the 
simulation has been shown to measurably influence the firm yield estimate, unless the inflow 
sequence is 500 more years long for large storage reservoirs. Flow records for sufficiently 
unregulated stream gauge locations are generally much less than 100 years in length. 

The scanning analysis does not account for precipitation to or evaporation from the reservoir 
surface. Additionally, monthly peak use factors are set at 0.9 for January through March, 1.1 for 
July through September, and 1.0 for all remaining months. The equation used to estimate the 
yield of the reservoir in the scanning analysis is: 

S ( j) = Qsi ( j) - a ( j)n( j)Qy - Qr ( j) - Qso ( j) + S( j - 1) 

where the terms are: 
S(j) water in active storage at the end of month j (millions of gallons); 
Qsi(j) streamflow into the reservoir in month j (millions of gallons); 
" (j) peak use factor for month j; 
n(j) number of days in month j (days); 
Qy scanning analysis reservoir firm yield (millions of gallons per day); 
Qr(j) required release rate for month j (millions of gallons); 
Qso(j) uncontrolled reservoir release rate in month j (millions of gallons); and 
S(j-1) water in active storage at the end of the previous month (millions of gallons). 

The streamflows into the reservoir (Qsi) are the transformed streamflow values calculated when 
the Calculate|Transform USGS data option is selected. Required releases are the values 
specified in the Data|Reservoir characteristics dialog box. Uncontrolled reservoir releases are 
anything in excess of the total reservoir capacity specified in the Data|Reservoir characteristics 
dialog box. The reservoir is assumed to be at full capacity at the beginning of the first month in 
the analysis. To calculate the scanning analysis yield, the FYE iterates over the scanning yield, 
Qy. A small value is selected for Qy, and the amount of water in active storage during each 
month of the simulation is calculated.  If the reservoir never empties during the simulation, Qy is 
incrementally increased and the simulation is repeated until the reservoir is empty during exactly 
one month in the simulation. The value of Qy during the simulation when the reservoir empties 
once during the simulation is the scanning yield of the surface water reservoir. For a more 
detailed description of the scanning yield calculation, see Chapter 4 of the DEP guidance 
document (1996). 

The FYE presents a graph of the scanning yield results in a new window. The date is plotted on 
the x-axis, and reservoir storage is plotted along the y-axis (as a percentage of reservoir 
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capacity). The percentage of years in the simulation during which the reservoir did not 
completely refill is displayed below the graph, as is the estimated scanning yield of the reservoir. 
To copy the graph and paste it into another application such as a word processing application, 
select Copy from the Graph menu at the top of the graph window. To print the graph, select the 
correct printer and print orientation on the Graph|Printer setup dialog box, and then select 
Graph|Print. To close the graph window, click on the Close button at the bottom of the window. 
An example graph of the results of the scanning analysis appears in Figure 2.1 below. 

After the scanning analysis has been performed, the scanning yield of the surface water reservoir 
appears at the bottom of the main program window. 
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Figure 2.1 Graph of the scanning analysis results. 

2.6.3 Generate 1,000 years of meteorological data 

Ideally, the firm yield analysis for a reservoir would be performed using a very long period of 
record that includes climate and streamflow sequences that occurred during the very worst 
possible droughts. In reality, even the longest periods of record are usually less than 100 years in 
length, sometimes much less. If the scanning analysis demonstrates that the reservoir does not 
refill for at least one month a year in 15% or more of the period of record, DEP requires that a 
1,000 year sequence of meteorological and streamflow data be used in the firm yield analysis. 

The 1,000 year sequence of meteorological and streamflow data is generated using a sampling 
technique termed “bootstrapping” in Chapter 6 of DEP’s guidance (1996). The period of record 
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for which both meteorological and streamflow data are available is divided into two year periods 
each beginning in the month of April and ending in March, two years later. Five hundred two 
year periods are then selected at random from the entire period of record, resulting in 1,000 years 
of data. See the DEP guidance for a more detailed description of the bootstrapping technique 
and the reasons behind it. 

To generate the 1,000 year sequence of data, select Calculate|Generate meteorological data. A 
dialog box will appear asking whether the 1,000 years of data should be generated from the 
entire period of record or from only a subset of the data. Specify the subset of the period of 
record which should be used to generate the 1,000 year sequence of data, then click Ok. The 
1,000 year sequence of data will be generated, as will be indicated at the bottom of the main 
window of the FYE. 

2.6.4 Estimating the firm yield 

The Calculate|Estimate firm yield option calculates the firm yield for the reservoir or reservoir 
system. This option will not be accessible until all data necessary to perform the analysis have 
been entered. These data include meteorological data, streamflow data, reservoir characteristics, 
bathymetry data, withdrawals by other users, peak use factors, and evaporation rates. 
Additionally, the streamflow data transform must have been performed to estimate inflows to the 
reservoir, and a scanning analysis must have been performed. If the scanning analysis indicates 
that the reservoir does not refill at least once during 15% of the years in the period of record, a 
1,000 year sequence of meteorological data must also be generated before the firm yield can be 
calculated. Selecting Calculate|Estimate firm yield brings up a dialog box that allows the user to 
select between using actual meteorological data or the 1,000 year series of generated data. If the 
user specifies that actual data should be used in the analysis, the FYE asks the user to specify the 
years to use in the analysis. The maximum range is the period of overlap for meteorological and 
streamflow data. The analysis will begin in April of the first year specified and will end in 
March of the last year specified. 

The firm yield of the reservoir system is estimated using an algorithm similar to that for the 
scanning analysis, but including terms to account for precipitation on and evaporation from the 
reservoir surface. Additionally, site-specific peak use factors are employed instead of using 
default values. The equation used to estimate the firm yield of the surface water reservoir is: 

S ( j) = Ar ( j)[P( j) - Ep ( j)] + Qsi ( j) - a ( j)n( j)Qy - Qr ( j) - Qso ( j) + S ( j - 1) 

where the terms are the same as in Section 2.6.2 with the following additions: 
Ar(j) reservoir surface area in month j; 
P(j) total precipitation in month j; and 
Ep(j) total evaporation from the reservoir surface in month j. 

Additionally, Qy is now the estimated firm yield for the reservoir instead of the scanning yield. 
The inputs to the equation above are those that were previously entered in the dialog boxes 
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accessed by using the Data menu. To calculate the firm yield, the FYE iterates over the yield, 
Qy. A small value is selected for Qy, and the amount of water in active storage during each 
month of the simulation is calculated.  If the reservoir never empties during the simulation, Qy is 
incrementally increased and the simulation is repeated until the reservoir is empty during exactly 
one month in the simulation. The value of Qy during the simulation when the reservoir empties 
once during the simulation, when multiplied by a correction factor, is the firm yield of the 
surface water reservoir. The correction factor adjusts for the error in the firm yield estimate 
made using a monthly time step model (as opposed to a smaller time step). This corrected firm 
yield estimate is: 

Qy (Dt = 1 month)
Qy = 0.67( B S )o max1 + Aoe 

where the terms are: 
Qy firm yield estimate (million gallons per day); 
)t time step; 
Smax active reservoir storage capacity (millions of gallons); 
Ao constant (0.0696); and 
Bo constant (-0.0589). 

For a more detailed description of the firm yield calculation and correction factor, see Chapter 7 
of the DEP guidance document (1996). 

The FYE presents a graph of the firm yield analysis results in a new window. The date is plotted 
on the x-axis, and reservoir storage is plotted along the y-axis (as a percentage of reservoir 
capacity). The estimated firm yield of the reservoir is displayed beneath the graph. To copy the 
graph and paste it into another application such as a word processing application, select Copy 
from the Graph menu at the top of the graph window. To print the graph, select the correct 
printer and print orientation on the Graph|Printer setup dialog box, and then select Graph|Print. 
To close the graph window, click on the Close button at the bottom of the window. An example 
graph of the results of the firm yield analysis appears in Figure 2.2 below. 

After the scanning analysis has been performed, the scanning yield of the surface water reservoir 
appears at the bottom of the main program window. 
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Figure 2.2 Graph of sample firm yield analysis results. 

2.7 Reservoir system analysis 

The options beneath the System menu heading are used when performing a firm yield analysis of 
a system of reservoirs. Because the analysis of a system of reservoirs requires detailed 
information about each individual reservoir in the system, the FYE requires that a firm yield 
analysis be performed for each reservoir in the system prior to calculating the yield of the 
system. The information in the saved data files for the individual reservoirs is then used to 
estimate the yield of the system of reservoirs. 

The first step in performing a yield analysis for a reservoir system is to specify the reservoirs in 
the system using the System|Load reservoir data option. After this option is selected, the FYE 
will display a dialog box asking for the number of reservoirs in the system and for the datafile 
associated with each reservoir. The FYE can be used to estimate yields for reservoir systems 
consisting of between two and ten reservoirs in series or parallel (or a combination of the two). 
Specify the number of reservoirs in the system in the text box at the top of the dialog box. Then 
for each reservoir in the system click the Data File button. Clicking the Data File button brings 
up a standard Windows dialog box for opening files. Select the appropriate data file then click 
Open. The FYE will check to make sure the file is a Firm Yield Estimator file and will check 
that all necessary data for the reservoir are contained in the file. The FYE will then display an 
error message if data are incomplete or will return to the Load reservoir data dialog box. The 
Load reservoir data dialog box will display the title given to each reservoir after the file has been 
specified. Specify the data files for each reservoir in the system, then click Ok. 
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The System relationships option is used to specify the relationships between reservoirs in the 
system and to specify the meteorological data to use in the analysis. This option is disabled until 
all necessary data have been specified in the Load reservoir data dialog box. The System 
relationships dialog box contains a list box for each reservoir in the system. For each reservoir 
in the system, click on the down arrow at the right side of the list box, and select the destination 
for outflow (both required releases and uncontrolled spills) from that reservoir. As an example, 
consider a two reservoir system where the outflow from Reservoir 1 flows into Reservoir 2. In 
this example, the user would specify “Reservoir 2" as the destination for outflow from Reservoir 
1, and “None” as the destination for outflow from Reservoir 2.  At the bottom of the dialog box, 
select a radio button indicating whether actual meteorological data should be used in the analysis 
or whether a 1,000 year sequence of data should be used in the analysis.  If Use actual 
meteorological data is selected, the period of analysis will be the period of overlap for 
meteorological data, streamflow data, and require release data for all the reservoirs in the system. 
If Generate a 1,000 year series of meteorological data to use in the analysis is selected, the 
1,000 year series will be generated by selecting 500 two-year sequences of data from the period 
of overlap, as discussed in Chapter 6 of DEP’s guidance (1996). 

The Estimate system yield option calculates the firm yield of the system of reservoirs. This 
option is disabled until the data in the Load reservoir data and System relationships dialog boxes 
are complete. The yield of the system of reservoirs is calculated as specified in Section 7.6 of 
DEP’s guidance document (1996). The yield of the system of reservoirs is displayed in a small 
dialog box. Click Ok to close this dialog box. With few exceptions, the firm yield of the system 
of reservoirs will be greater than or equal to the sum of the firm yields of the individual 
reservoirs in the system. 

System|Save system opens a standard Windows dialog box for saving files. Specify the directory 
in which the file should be saved and the filename, then click the Save button. The default 
filename extension for firm yield system analyses is .fys. Select the Cancel button to return to 
the FYE without saving the data file. 

System|Open system opens a standard Windows dialog box for opening files. Specify the file 
containing the saved system analysis, then click the Open button. 

2.8 Help files 

All information included in the technical documentation for the software is also available in the 
help files accompanying the FYE. Select Help from the menu at the top right of the main FYE 
window, or click on any of the help buttons that appear in most of the dialog boxes created by 
the FYE. It is then possible to search the help files for specific topics or to scan through the table 
of contents to identify topics of interest. 
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3 Tutorial – Example case 
This tutorial introduces a reservoir in Massachusetts and leads the user through an analysis of the 
firm yield of the surface water reservoir. First, the user selects a nearby meteorological station 
and stream gauge and enters reservoir specific data into the FYE. The tutorial leads the user 
through a transformation of the streamflow data into inflow data for the reservoir.  The user then 
performs a scanning analysis, generates 1,000 years of meteorological and streamflow data, and 
finally, performs the firm yield analysis for the reservoir. 

Upon starting the FYE, the title screen of the FYE is displayed with a menu at the top and three 
buttons at the bottom. Click the Continue button to proceed. The title screen of the FYE is 
shown in Figure 3.1 below. 

Figure 3.1 The title screen of the Firm Yield Estimator 
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The FYE will then display information about the reservoir under analysis in the main program 
window. The top two sections contain information about the meteorological and streamflow 
stations selected for the analysis. The third section lists reservoir specific sets of parameters and 
whether or not they have already been entered. The bottom section summarizes in boldface the 
analyses that have been performed on the reservoir and the results (if available). Figure 3.2 
shows the main window of the FYE immediately after running the program and clicking the 
Continue button. 

Figure 3.2 The main window of the FYE immediately after clicking Continue 
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The hypothetical reservoir considered in the tutorial is a 1 billion gallon reservoir located near 
Amherst, Massachusetts. 

The first step in performing the firm yield analysis is to select an appropriate nearby 
meteorological station and stream gauge. Table 4.1 lists all meteorological stations included in 
the FYE database. Factors that should be included in this decision include proximity to the 
reservoir, years for which data are available, and completeness of the meteorological data set, 
among others. The meteorological station at Amherst would clearly be an appropriate station to 
use for the hypothetical reservoir. To select this station, click on the Data menu at the top of the 
FYE window, and select the Select met file from list option. The FYE will then open a dialog 
box asking the user to select the directory in which the meteorological data files are stored. The 
meteorological data files are on the FYE CD-ROM. Select the CD-ROM drive from the list box 
(or the appropriate drive if the files have been transferred to the hard drive) underneath the 
“Drive:” heading, then double-click on the directories until reaching the Met\MA directory 
which contains the data files for Massachusetts meteorological data stations. At this point, the 
folder next to the MA directory should be open as shown in Figure 3.3 below. Then click the Ok 
button. 

Figure 3.3 Selecting the meteorological files directory 
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The FYE will display a dialog box in which the meteorological station an be selected from the 
list of all stations in the specified directory (see Figure 3.4). Select the “AMHERST” station 
from the list, then click Ok. Information about the meteorological station will now be displayed 
in the main window of the FYE. 

Figure 3.4 Selecting the meteorological data station 

The FYE will then display a dialog box stating that meteorological data are missing for several 
months.  Select the radio button next to Replace missing data with average values for that month, 
then click Ok. The meteorological data are now complete. 

The procedure for selecting a stream gauge is very similar to that for selecting a meteorological 
station. First select an appropriate stream gauge for the analysis. Factors that should influence 
the decision are proximity to the reservoir, the years for which data are available, and the extent 
to which streamflow is regulated above the stream gauge, among other factors.  Tables 4.3 and 
4.5 can assist in the decision making process, but DEP should be consulted regarding the 
selection of an appropriate stream gauge to use in the firm yield analysis. The Mill River At 
Northampton, Ma is an appropriate station to use for the hypothetical reservoir. Select the 
Data|Select USGS file from list option from the menu, specify the directory containing the 
streamflow data files (in the Stream\MA directory on the CD-ROM), then select “Mill River At 
Northampton, Ma” from the list and click Ok. Information about both the selected 
meteorological station and the selected stream gauge will now be displayed in the main window 
of the FYE. The distance between the meteorological station and the streamgauge (in this case 
7.7 miles) will also be displayed. 
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The next step in performing the firm yield analysis is to enter descriptive characteristics of the 
reservoir and watersheds. Select Data|Reservoir characteristics from the menu of the FYE. The 
dialog box shown in Figure 3.5 will be displayed on the screen. Enter the areas of the reservoir 
watershed, the watershed contributing to the stream gauge, and the reservoir capacity. Specify 
the area of the reservoir watershed to be 5.85 square miles, the area of the stream gauge 
watershed to be 54 square miles, and the usable reservoir capacity to be 1,000 million gallons 
(1.0 billion gallons). The analysis will assume that there are required releases from the 
hypothetical reservoir totaling 18.6 million gallons per month, so select the Constant release rate 
radio button, enter the release rate of 18.6 million gallons in the edit box, and click Ok. 

Figure 3.5 Reservoir characteristics dialog box 
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Next, select Data|Bathymetry from the menu to show the bathymetry dialog box displayed in 
Figure 3.6 below. The area of a surface water reservoir becomes smaller as the amount of water 
in the reservoir decreases (while the area of the reservoir’s watershed increases by the same 
amount). The DEP guidance (1996) requires that a continuous approximate mathematical 
relationship be developed between reservoir surface area and reservoir storage, and suggests that 
developing a mathematical relationship is most easily accomplished by developing a third order 
or higher order polynomial function using ordinary least-squares regression.  The bathymetry 
dialog box allows the user to specify the coefficients of a best-fit polynomial for the surface 
area/reservoir storage relationship. For the hypothetical reservoir, specify a zero-order 
polynomial with a surface area of 0.063 square miles (set the constant to 0.063) then click Ok. 

Figure 3.6 Bathymetry dialog box 
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Next, specify the evaporation rate from the reservoir by selecting the Data|Evaporation rates 
menu item. This will bring up the evaporation rates dialog box (Figure 3.7). If site-specific 
monthly evaporation rates are known for a reservoir, the user can select the Specify monthly 
evaporation rates radio button and specify evaporation rates (in inches) for each month then 
click Ok. For the hypothetical reservoir, allow the FYE to calculate evaporation rates from the 
meteorological data. Select the Estimate evaporation from meteorological data radio button, 
then click Ok. A second dialog box will appear (Figure 3.8) requesting the longitude and 
elevation of the reservoir. Specify the longitude to be 72.484EW and the elevation to be 470 
feet above sea level, then click Ok. 

Figure 3.7 Evaporation data dialog box 

Figure 3.8 Second evaporation dialog box 
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Peak use factors adjust for seasonal variations in water use. Generally, water use is higher in the 
summer months than in the winter. Select the Data|Peak use factors option from the menu, and 
enter the following peak use factors: 1.08 in January, 1.03 in February, 1.20 in March, 1.15 in 
April, 1.19 in May, 1.10 in June, 1.19 in July, 1.13 in August, 0.85 in September, 0.56 in 
October, 0.54 in November, and 0.99 in December. Then click Ok. The peak use factor dialog 
box is shown in Figure 3.9. 

Figure 3.9 Peak use factors dialog box 
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Finally, specify withdrawals by other users. Assume there are no withdrawals by other users 
from the hypothetical reservoir. Select the Data|Withdrawals by other users option and accept 
the default of zero withdrawals in every month by clicking Ok. Figure 3.10 shows the dialog box 
used to specify withdrawals by other users. 

Figure 3.10 Withdrawals by other users dialog box 
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After all the above data have been entered, one can begin the analysis of the data. Read through 
the information presented in the main window of the FYE to ensure that all data have been 
entered. This screen should display the name of the meteorological station and stream gauge. 
Additionally, this window should indicate that reservoir characteristics, bathymetry data, 
withdrawals by other users, peak use factors, and evaporation rates are complete.  Figure 3.11 
shows the main window as it should look at this stage of the analysis. If any of these data have 
not been entered, go back and enter the missing data now. 

Figure 3.11 Main window of the Firm Yield Estimator after entering data 
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The first calculation that needs to be performed is the calculation of inflows to the surface water 
reservoir. To do this, select the Calculate|Transform USGS data option. A few additional pieces 
of information are necessary prior to calculating inflows to the reservoir from existing 
streamflow and meteorological data. Specify the average watershed elevation to be 850 feet, the 
mean channel slope to be 182 ft/mile, and the maximum soil retention to be 6.39 inches in the 
stream gauge transform dialog box (Figure 3.12). Allow the FYE to calculate the average annual 
precipitation and snowfall for the reservoir from the meteorological data and click Ok. The FYE 
will display a warning message indicating that streamflow data in the month of November 1938 
are incomplete. This is expected because this is the first month in which streamflow data were 
collected at this particular stream gauge, and the first date on which data were collected was 
November 18, 1938. Click Ok to dismiss the error message. The bottom of the main window 
will now display a message informing the user that the streamflow data have been transformed. 

Figure 3.12 Dialog box for streamflow transform 
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After the streamflow data have been transformed, the Perform scanning analysis option will be 
accessible on the Calculate menu. Select this option to perform a scanning analysis for the 
reservoir. The FYE will display the results of the scanning analysis graphically as shown in 
Figure 3.13. For the hypothetical reservoir, the scanning yield of the reservoir is 3.188 million 
gallons per day. More importantly, the scanning analysis shows that the reservoir does not refill 
during only 3.7% of the years in the period of record. If the reservoir does not refill during 15% 
or more of the period of record, it is necessary to generate a 1,000-year sequence of streamflow 
and meteorological data prior to performing the full firm yield analysis. Click the Close button 
at the bottom of the graph to close the graph window and continue with the analysis. 

Figure 3.13 Results of the scanning analysis 
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Although it is unnecessary to do so for the hypothetical reservoir, the next step in a typical firm 
yield analysis is to generate a 1,000-year sequence of data. For the sake of practice, select 
Calculate|Generate meteorological data. The FYE gives the user the option of generating the 
1,000-year sequence from the entire period for which streamflow and meteorological data are 
available or selecting a subset of the period to use when generating data (see Figure 3.14). Select 
the radio button labeled Use the entire period for which data are available and click Ok. The 
FYE has now generated 1,000 years of meteorological data, as indicated at the bottom of the 
main window. 

Figure 3.14 Dialog box for the generation of the 1,000-year data sequence 
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The final step is the actual estimation of the firm yield for the surface water reservoir. Select the 
Calculate|Estimate firm yield option. The FYE gives the user the option of performing the firm 
yield calculation based on actual meteorological and streamflow data, or the generated 1,000­
year sequence of data (see Figure 3.15). Because the scanning analysis indicated that using the 
1,000-year sequence of data is unnecessary for the hypothetical reservoir, select the button 
labeled Actual meteorological and streamflow data and click Ok. As it did for the scanning 
analysis, the FYE will display a graph of the results of the firm yield analysis (Figure 3.16). The 
firm yield of the hypothetical reservoir is 3.322 million gallons per day. Click Close to close the 
graph and return to the main window of the program. 

Figure 3.15 Dialog box for selecting data in the firm yield analysis 

If Actual meteorological and streamflow data is selected, a second dialog box appears asking the 
user to specify the years to use in the analysis. This option allows the user to specify a period 
less than the period of overlap for the meteorological and streamflow data.  For example, the user 
could exclude the 1960's drought of record (after receiving DEP approval) and instead use only 
the period from 1970 through 1993 to estimate the firm yield. Simply accept the maximum 
range (1939 through 1993) by pressing the Ok button. 
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Figure 3.16 Graph of the results of the firm yield analysis 

The firm yield analysis of the hypothetical reservoir is now complete. To save the analysis, 
select Save from the File menu. Select the directory in which to save the file and specify a 
filename. Then click on the Save button in the dialog box. To close the FYE, select Exit from 
the File menu or click on the x in the top right corner of the main program window. 
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4 Database descriptions 
Two databases are included on the CD-ROM provided with the Firm Yield Estimator, one 
containing meteorological data and one containing streamflow data.  The meteorological 
database contains maximum and minimum temperature, precipitation, and snowfall data for 
meteorological stations in Massachusetts and in neighboring states at stations within about 15 
miles of the Massachusetts border. The streamflow database contains daily streamflow 
measurements at USGS stream gauge locations in Massachusetts and stream gauge locations in 
neighboring states but near the Massachusetts border. The sections below describe the data 
provided in these two databases in detail. CDW Consultants, Inc. provided assistance in 
compiling the databases. 

4.1 Meteorological database 

The meteorological data provided with the Firm Yield Estimator were obtained in electronic 
format on CD-ROM’s from the National Oceanic and Atmospheric Administration (NOAA, 
1995a; NOAA, 1995b). The NOAA data include daily measurements of maximum temperature, 
minimum temperature, precipitation, and snowfall as well as other parameters for some stations, 
such as soil temperatures and evaporation. The NOAA data were preprocessed using the Firm 
Yield Estimator to obtain the monthly meteorological parameters required to estimate the yield 
of a surface water reservoir per DEP’s guidance (DEP, 1996). These preprocessed data files are 
the files that are included in the Firm Yield Estimator’s meteorological database. 

The meteorological stations that are included in the database are summarized in Tables 4.1 and 
4.2 below. Figure 4.1 is a map showing the locations of all the meteorological stations in the 
database. A large number of meteorological stations for which NOAA provides data include 
only a few years of data or are missing data that are necessary to perform the firm yield analysis 
(such as precipitation or temperature data). The database includes all stations in Massachusetts 
for which the necessary parameters were provided for the minimum time period required by 
DEP, April 1960 through March 1990. The database also includes stations in bordering states 
that are near the Massachusetts border. This includes stations in Vermont and New Hampshire 
that are south of 43EN latitude, stations in Connecticut and Rhode Island that are north of 41E45' 
N latitude, and stations in New York that are east of 74EW longitude and between 41E45' N and 
43EN latitude. Meteorological data for Hartford’s Brainard Field and Providence’s T.F. Green 
State Airport are also included because they represent large, relatively complete data sets that are 
just south of the 41E45' N latitude cutoff. 

Table 4.1 presents each meteorological station by name and station number, the dates for which 
data are available, and the latitude and longitude of the station. Table 4.2 provides a summary of 
the completeness of the monthly meteorological data for each station. 
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The filenames for the meteorological data files consist of the station number with the extension 
.met. Hence, the filename for Boston’s Logan International Airport is 190770.met. The format 
of the meteorological data files is relatively simple. The first line of the file contains an integer 
specifying the number of months included in the datafile.  The second line of the file is the 
station number and the third line is the station name. The fourth and fifth lines are the latitude 
and longitude of the meteorological station.  All subsequent lines are meteorological data, one 
line per month. Each line consists of (from left to right) the month (an integer between 1 and 
12), the year, the maximum monthly temperature, the minimum monthly temperature, the total 
monthly snowfall, and the total monthly precipitation.  If any data are missing for a given month, 
an error code of -99999 is reported instead of the missing parameter(s). The two pages of the 
data file for Boston’s Logan International Airport (filename 190770.met) are shown in Appendix 
A. 

4.2 Streamflow database 

The streamflow data provided with the Firm Yield Estimator were downloaded from the United 
States Geological Survey (USGS) website at http://water.usgs.gov.  Daily streamflow data were 
downloaded for all stream gauges in Massachusetts for which data were available for the period 
from April 1, 1960 through March 30, 1990. Additionally, data were downloaded for all stream 
gauges in bordering states within about 15 miles of the Massachusetts border. 

Figure 4.2 and Table 4.3 present the stream gauge locations that are included in the Firm Yield 
Estimator’s database. From left to right, the table includes the name of the stream gauge, the 
station number for the stream gauge, the first and last dates for which streamflow measurements 
are available, and the latitude and longitude of the stream gauge location. 

The filenames for the streamflow data files consist of the station number for the stream gauge 
plus the extension .txt. Hence, the filename for data collected from the Shawsheen River near 
Wilmington, Massachusetts (station number 01100600) is 01100600.txt. Approximately the first 
35 lines of each streamflow data file are a header for the file.  Each of these lines begins with the 
“#” character.  The header for each file contains descriptive parameters for the stream gauge 
(location, latitude, longitude, drainage area, etc.) as well as a description of the format for the 
rest of the file. After the header lines, the first line of the file contains the column headings 
“Date”, “Discharge”, and “Flags”.  The next line is a row of tab-delimited data type codes that 
describe a 10-character-wide date (10d), an 8-character-wide numeric value for discharge (8n), 
and a 2-character-wide string as a qualifying flag (2s). All following lines are tab-delimited data 
values of date and discharge. The first two pages of the data file for the Shawsheen River near 
Wilmington, Massachusetts (filename 01100600.txt) are shown in Appendix B. 

Almost all stream gauges in the vicinity of Massachusetts are regulated to some extent upstream 
of the stream gauge. Table 4.4 summarizes the flow rate at each location in the database. Table 
4.5 gives a brief description of the extent to which each station in the streamflow database is 
regulated. DEP requires that the analyst employ data from the nearest U.S. Geological Survey 
streamgauge to the reservoir that is sufficiently unregulated and includes the period from April 1, 
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1960 to March 31, 1990. Table 4.5 is intended to give some guidance as to the extent of 
regulation at each stream gauge; however, DEP must be consulted about the proposed 
streamgauge before beginning the analysis. 
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Figure 4.1 Map of meteorological stations in the database.  The numbers correspond to the Map ID’s in Table 4.1. 
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Table 4.1 Meteorological stations reporting data between 1960 and 1990 
Station Name Map 

ID 
Station 
Number 

Dates Latitude 
(North) 

Longitude 
(West) 

Massachusetts 

Amherst 1 190120 January 1926 to December 1993 42°24' 72°32' 
Barre Falls/Dam 2 190408 February 1959 to December 1993 42°26' 72°02' 
Bedford 3 190535 May 1957 to December 1993 42°29' 71°17' 
Birch Hill/Dam 4 190666 June 1948 to December 1993 42°38' 72°07' 
Milton/Blue Hill Observatory 5 190736 January 1926 to December 1993 42°13' 71°07' 
Boston/Logan International Airport 6 190770 January 1920 to December 1993 42°22' 71°02' 
Brockton 7 190860 June 1948 to December 1993 42°05' 71°01' 
Buffumville/Lake 8 190998 May 1959 to December 1993 42°07' 71°54' 
East Wareham 9 192451 January 1926 to December 1993 41°46' 70°40' 
Edgartown 10 192501 June 1948 to December 1993 41°23' 70°31' 
Framingham 11 192975 June 1948 to November 1989 42°17' 71°25' 
Haverhill 12 193505 June 1948 to December 1993 42°46' 71°04' 
Hingham 13 193624 September 1960 to December 1993 42°14' 70°55' 
Hyannis 14 193821 April 1926 to December 1993 41°40' 70°18' 
Knightville/Dam 15 193985 June 1948 to December 1993 42°17' 72°52' 
Lawrence 16 194105 January 1926 to December 1993 42°42' 71°10' 
Middleton 17 194744 June 1948 to December 1993 42°36' 71°01' 
New Bedford 18 195246 June 1948 to December 1993 41°38' 70°56' 
Plymouth-Kingston 19 196486 June 1948 to December 1993 41°57' 70°40' 
Reading 20 196783 January 1960 to December 1993 42°31' 71°08' 
Rochester 21 196938 November 1951 to December 1993 41°47' 70°55' 
Taunton 22 198367 June 1948 to December 1993 41°54' 71°04' 
Tully/Lake 23 198573 July 1949 to December 1993 42°38' 72°13' 
West Medway 24 199316 January 1957 to December 1993 42°08' 71°26' 
Worcester/Municipal Airport 25 199923 June 1948 to December 1993 42°16' 71°52' 
Connecticut 

Burlington 26 60973 January 1937 to December 1993 41°48' 72°56' 
Coventry 27 61689 April 1957 to September 1993 41°48' 72°21' 
Falls Village 28 62658 June 1948 to December 1993 41°57' 73°22' 
Hartford/Brainard Field 29 63451 January 1920 to December 1993 41°44' 72°39' 
Hartford/Bradley International Airport 30 63456 August 1954 to December 1993 41°56' 72°41' 
Mansfield/Hollow Lake 31 64488 May 1952 to December 1993 41°45' 72°11' 
Norfolk 32 65445 September 1942 to December 1993 41°58' 73°13' 
Storrs 33 68138 June 1888 to December 1993 41°48' 72°15' 
Rhode Island 

Providence/T.F. Green State Airport 34 376698 June 1948 to December 1993 41°44' 71°26' 
New Hampshire 

Keene 35 274399 January 1926 to December 1993 42°55' 72°16' 
Massabesic/Lake 36 275211 June 1948 to December 1993 42°59' 71°24' 
Nashua 37 275712 June 1948 to December 1993 42°46' 71°27' 
Peterboro 38 276697 June 1948 to December 1993 42°51' 71°57' 
Vermont 

Readsboro 39 436761 June 1948 to December 1993 42°45' 72°56' 
Vernon 40 438600 June 1948 to December 1993 42°46' 72°31' 
New York 

Albany/County Airport 41 300042 June 1938 to December 1993 42°45' 73°48' 
Grafton 42 303360 September 1950 to December 1993 42°47' 73°28' 
Hudson/Correctional Facility 43 304025 March 1957 to December 1993 42°15' 73°48' 
Millbrook 44 305334 May 1948 to December 1993 41°51' 73°37' 
Troy/Lock and Dam 45 308600 November 1932 to December 1993 42°45' 73°41' 
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Table 4.2 Missing meteorological data summary 
Name Total 

months 
Number of months with missing data Percent of months with missing data 

Max. 
temp. 

Min. 
temp. 

Snow Precip. Max. 
temp. 

Min. 
temp. 

Snow Precip. 

Massachusetts 

Amherst 816 2 2 16 2 0.2% 0.2% 2.0% 0.2% 
Barre Falls/Dam 419 1 1 2 0 0.2% 0.2% 0.5% 0.0% 
Bedford 440 3 3 4 3 0.7% 0.7% 0.9% 0.7% 
Birch Hill/Dam 547 2 3 2 0 0.4% 0.5% 0.4% 0.0% 
Milton/Blue Hill Observatory 816 6 6 134 8 0.7% 0.7% 16.4% 1.0% 
Boston/Logan International Airport 888 0 0 13 0 0.0% 0.0% 1.5% 0.0% 
Brockton 547 36 36 87 3 6.6% 6.6% 15.9% 0.5% 
Buffumville/Lake 416 0 0 14 0 0.0% 0.0% 3.4% 0.0% 
East Wareham 816 7 7 37 1 0.9% 0.9% 4.5% 0.1% 
Edgartown 547 3 3 98 3 0.5% 0.5% 17.9% 0.5% 
Framingham 498 15 15 22 14 3.0% 3.0% 4.4% 2.8% 
Haverhill 547 12 12 10 8 2.2% 2.2% 1.8% 1.5% 
Hingham 400 0 0 0 0 0.0% 0.0% 0.0% 0.0% 
Hyannis 813 94 94 289 70 11.6% 11.6% 35.5% 8.6% 
Knightville/Dam 547 3 3 12 1 0.5% 0.5% 2.2% 0.2% 
Lawrence 816 2 2 14 6 0.2% 0.2% 1.7% 0.7% 
Middleton 547 1 1 22 1 0.2% 0.2% 4.0% 0.2% 
New Bedford 547 3 3 5 2 0.5% 0.5% 0.9% 0.4% 
Plymouth-Kingston 547 1 1 24 1 0.2% 0.2% 4.4% 0.2% 
Reading 408 0 0 0 0 0.0% 0.0% 0.0% 0.0% 
Rochester 506 2 2 61 2 0.4% 0.4% 12.1% 0.4% 
Taunton 547 0 1 11 0 0.0% 0.2% 2.0% 0.0% 
Tully/Lake 534 6 6 2 1 1.1% 1.1% 0.4% 0.2% 
West Medway 444 1 1 1 1 0.2% 0.2% 0.2% 0.2% 
Worcester/Municipal Airport 547 0 0 0 0 0.0% 0.0% 0.0% 0.0% 
Connecticut 

Burlington 684 305 305 187 17 44.6% 44.6% 27.3% 2.5% 
Coventry 438 29 32 41 28 6.6% 7.3% 9.4% 6.4% 
Falls Village 547 0 0 54 0 0.0% 0.0% 9.9% 0.0% 
Hartford/Brainard Field 888 8 8 161 8 0.9% 0.9% 18.1% 0.9% 
Hartford/Bradley International Airport 473 0 0 0 0 0.0% 0.0% 0.0% 0.0% 
Mansfield/Hollow Lake 500 1 1 8 1 0.2% 0.2% 1.6% 0.2% 
Norfolk 616 1 1 1 1 0.2% 0.2% 0.2% 0.2% 
Storrs 1267 34 33 193 33 2.7% 2.6% 15.2% 2.6% 
Rhode Island 

Providence/T.F. Green State Airport 547 7 7 7 1 1.3% 1.3% 1.3% 0.2% 
New Hampshire 

Keene 816 3 3 127 2 0.4% 0.4% 15.6% 0.2% 
Massabesic/Lake 547 17 16 123 15 3.1% 2.9% 22.5% 2.7% 
Nashua 547 2 3 25 2 0.4% 0.5% 4.6% 0.4% 
Peterboro 547 30 30 31 31 5.5% 5.5% 5.7% 5.7% 
Vermont 

Readsboro 547 34 34 3 2 6.2% 6.2% 0.5% 0.4% 
Vernon 547 33 33 9 1 6.0% 6.0% 1.6% 0.2% 
New York 

Albany/County Airport 667 0 0 0 0 0.0% 0.0% 0.0% 0.0% 
Grafton 520 5 5 14 5 1.0% 1.0% 2.7% 1.0% 
Hudson/Correctional Facility 442 15 16 64 20 3.4% 3.6% 14.5% 4.5% 
Millbrook 548 10 11 33 15 1.8% 2.0% 6.0% 2.7% 
Troy/Lock and Dam 734 287 287 310 288 39.1% 39.1% 42.2% 39.2% 
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Figure 4.2 Map of streamflow stations in the database.  The numbers correspond to the Map ID’s in Table 4.3. 
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Table 4.3 USGS stream discharge data 
Station Name Map 

ID 
Station 
Number 

First Date Last Date Latitude Longitude 

Massachusetts 

Westfield River At Knightville, MA 1 01179500 08/26/09 09/30/90 42°17'16" 72°51'53" 
North Nashua River Near Leominster, MA 2 01094500 09/17/35 09/30/92 42°30'06" 71°43'23" 
Squannacook River Near West Groton, MA 3 01096000 10/01/49 09/30/92 42°38'03" 71°39'30" 
Nashua River At East Pepperell, MA 4 01096500 10/01/35 09/30/96 42°40'03" 71°34'32" 
Assabet River At Maynard, MA 5 01097000 07/11/41 09/30/96 42°25'55" 71°27'01" 
Nashoba Brook Near Acton, MA 6 01097300 07/26/63 09/30/96 42°31'19" 71°24'15" 
Concord R Below R Meadow Brook, At Lowell, MA 7 01099500 12/16/36 09/30/96 42°38'12" 71°18'09" 
Merrimack River Bl Concord River At Lowell, MA 8 01100000 06/01/23 09/30/96 42°38'45" 71°17'56" 
Shawsheen River Near Wilmington, MA 9 01100600 11/21/63 09/30/96 42°34'05" 71°12'55" 
Parker River At Byfield, MA 10 01101000 10/26/45 09/30/96 42°45'10" 70°56'46" 
Ipswich River At South Middleton, MA 11 01101500 06/01/38 09/30/96 42°34'10" 71°01'39" 
Ipswich River Near Ipswich, MA 12 01102000 06/17/30 09/30/96 42°39'35" 70°53'39" 
Aberjona River At Winchester, MA 13 01102500 04/16/39 09/30/96 42°26'50" 71°08'22" 
Charles River At Dover, MA 14 01103500 10/01/37 09/30/96 42°15'22" 71°15'38" 
Mother Brook At Dedham, MA 15 01104000 10/01/31 09/30/96 42°15'18" 71°09'53" 
Charles River At Wellesley, MA 16 01104200 08/26/59 09/30/96 42°18'59" 71°13'42" 
Charles River At Waltham, MA 17 01104500 08/04/31 09/30/96 42°22'20" 71°14'03" 
Neponset River At Norwood, MA 18 01105000 10/01/39 09/30/96 42°10'39" 71°12'05" 
East Branch Neponset River At Canton, MA 19 01105500 10/01/52 09/30/96 42°09'16" 71°08'47" 
Wading River Near Norton, MA 20 01109000 06/01/25 09/30/96 41°56'51" 71°10'38" 
Quinsigamond River At North Grafton, MA 21 01110000 10/01/39 09/30/96 42°13'49" 71°42'41" 
Little River Near Oxford, MA 22 01124500 07/27/39 09/30/90 42°06'57" 71°53'26" 
Millers River Near Winchendon, MA 23 01162000 06/05/16 09/30/96 42°41'03" 72°05'02" 
Priest Brook Near Winchendon, MA 24 01162500 10/01/36 09/30/96 42°40'57" 72°06'56" 
Millers River At South Royalston, MA 25 01164000 07/27/39 09/30/90 42°37'47" 72°09'03" 
East Branch Tully River Near Athol, MA 26 01165000 06/13/16 09/30/90 42°38'32" 72°13'34" 
Millers River At Erving, MA 27 01166500 07/01/15 09/30/96 42°35'51" 72°26'19" 
Deerfield River At Charlemont, MA 28 01168500 06/19/13 09/30/96 42°37'33" 72°51'20" 
North River At Shattuckville, MA 29 01169000 12/13/39 09/30/96 42°38'18" 72°43'32" 
Deerfield River Near West Deerfield, MA 30 01170000 10/01/40 09/30/96 42°32'09" 72°39'14" 
Connecticut River At Montague City, MA 31 01170500 03/31/04 09/30/96 42°34'48" 72°34'30" 
Mill River At Northampton, MA 32 01171500 11/18/38 09/30/96 42°19'05" 72°39'21" 
Ware River Near Barre, MA 33 01172500 07/27/46 09/30/96 42°25'35" 72°01'30" 
Ware River At Intake Works Near Barre, MA 34 01173000 01/30/28 09/30/96 42°23'26" 72°03'39" 
Ware River At Gibbs Crossing, MA 35 01173500 08/20/12 09/30/96 42°14'10" 72°16'23" 
East Branch Swift River Near Hardwick, MA 36 01174500 01/01/37 09/30/96 42°23'36" 72°14'21" 
Swift River At West Ware, MA 37 01175500 10/01/12 09/30/96 42°16'04" 72°19'59" 
Quaboag River At West Brimfield, MA 38 01176000 08/19/12 09/30/96 42°10'56" 72°15'51" 
Chicopee River At Indian Orchard, MA 39 01177000 08/05/28 09/30/97 42°09'38" 72°30'52" 
North Nashua River At Fitchburg, MA 40 01094400 10/01/72 09/30/96 42°34'34" 71°47'19" 
Middle B Westfield River At Goss Heights, MA 41 01180500 07/14/10 09/30/90 42°15'31" 72°52'23" 
West Branch Westfield River At Huntington, MA 42 01181000 09/01/35 09/30/97 42°14'14" 72°53'46" 
Westfield River Near Westfield, MA 43 01183500 06/27/14 09/30/97 42°06'24" 72°41'58" 
West Branch Farmington River Near New Boston, MA 44 01185500 05/27/13 09/30/97 42°04'45" 73°04'24" 
East Branch Housatonic River At Coltsville, MA 45 01197000 03/08/36 09/30/97 42°28'10" 73°11'49" 
Housatonic River Near Great Barrington, MA 46 01197500 05/17/13 09/30/97 42°13'55" 73°21'19" 
Hoosic River At Adams, MA 47 01331500 10/01/31 09/30/97 42°36'40" 73°07'28" 
North Branch Hoosic River At North Adams, MA 48 01332000 06/22/31 09/30/90 42°42'08" 73°05'37" 
Hoosic River Near Williamstown, MA 49 01332500 07/19/40 09/30/97 42°42'21" 73°10'50" 
Green River At Williamstown, MA 50 01333000 09/20/49 09/30/97 42°42'32" 73°11'50" 
Connecticut 

Quinebaug R At Quinebaug, CT 51 01124000 10/01/31 09/30/97 42°01'20" 71°57'22" 
4-8
 



Table 4.3 USGS stream discharge data 
Station Name Map 

ID 
Station 
Number 

First Date Last Date Latitude Longitude 

Mount Hope R Nr Warrenville, CT 52 01121000 10/01/40 09/30/97 41°50'37" 72°10'10" 
Connecticut R At Thompsonville, CT 53 01184000 08/01/28 09/30/97 41°59'14" 72°36'21" 
West Branch Farmington R At Riverton, CT 54 01186000 10/01/55 09/30/97 41°57'46" 73°01'05" 
Housatonic R At Falls Village, CT 55 01199000 10/01/12 09/30/97 41°57'26" 73°22'11" 
Rhode Island 

Woonasquatucket River At Centerdale, RI 56 01114500 07/09/41 09/30/97 41°51'32" 71°29'16" 
Blackstone River At Woonsocket, RI 57 01112500 02/22/29 09/30/97 42°00'22" 71°30'13" 
Branch River At Forestdale, RI 58 01111500 01/24/40 09/30/97 41°59'47" 71°33'47" 
South Branch Pawtuxet River At Washington, RI 59 01116000 10/01/40 09/30/97 41°41'24" 71°33'59" 
Hunt River Near East Greenwich, RI 60 01117000 08/24/40 09/30/97 41°38'28" 71°26'45" 
New Hampshire 

Lamprey River Near Newmarket, NH 61 01073500 07/24/34 09/30/97 43°06'09" 70°57'11" 
Ashuelot River At Hinsdale, NH 62 01161000 07/11/14 09/30/97 42°47'07" 72°29'12" 
New York 

Hoosic River Near Eagle Bridge, NY 63 01334500 07/25/23 09/30/97 42°56'19" 73°22'39" 
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Table 4.4 Average flow of streams in the streamflow database 
Station Name Average flow (ft3/s) 

Massachusetts 
Aberjona River At Winchester, Ma 28.9 
Assabet River At Maynard, Ma 188.1 
Charles River At Dover, Ma 304 
Charles River At Waltham, Ma 305.3 
Charles River At Wellesley, Ma 282.9 
Chicopee River At Indian Orchard, Ma 916.9 
Concord R Below R Meadow Brook, At Lowell, Ma 645.6 
Connecticut River At Montague City, Ma 13920.9 
Deerfield River At Charlemont, Ma 897.5 
Deerfield River Near West Deerfield, Ma 1307.9 
East Branch Housatonic River At Coltsville, Ma 107.2 
East Branch Neponset River At Canton, Ma 50.6 
East Branch Swift River Near Hardwick, Ma 71.5 
East Branch Tully River Near Athol, Ma 81.8 
Green River At Williamstown, Ma 82.6 
Hoosic River At Adams, Ma 90.2 
Hoosic River Near Williamstown, Ma 272.9 
Housatonic River Near Great Barrington, Ma 526.5 
Ipswich River At South Middleton, Ma 63.5 
Ipswich River Near Ipswich, Ma 186.2 
Little River Near Oxford, Ma 49.5 
Merrimack River Bl Concord River At Lowell, Ma 7641.1 
Middle B Westfield River At Goss Heights, Ma 105 
Mill River At Northampton, Ma 97.8 
Millers River At Erving, Ma 637 
Millers River At South Royalston, Ma 327.6 
Millers River Near Winchendon, Ma 144.7 
Mother Brook At Dedham, Ma 76.3 
Nashoba Brook Near Acton, Ma 20.5 
Nashua River At East Pepperell, Ma 580.2 
Neponset River At Norwood, Ma 55.1 
North Branch Hoosic River At North Adams, Ma 96.5 
North Nashua River At Fitchburg, Ma 328.9 
North Nashua River Near Leominster, Ma 197.3 
North River At Shattuckville, Ma 186.7 
Parker River At Byfield, Ma 36.9 
Priest Brook Near Winchendon, Ma 32.8 
Quaboag River At West Brimfield, Ma 247.2 
Quinsigamond River At North Grafton, Ma 41.3 
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Table 4.4 Average flow of streams in the streamflow database 
Station Name Average flow (ft3/s) 

Shawsheen River Near Wilmington, Ma 58.5 
Squannacook River Near West Groton, Ma 112.1 
Swift River At West Ware, Ma 164.5 
Wading River Near Norton, Ma 72.7 
Ware River At Gibbs Crossing, Ma 294.4 
Ware River At Intake Works Near Barre, Ma 168.9 
Ware River Near Barre, Ma 95 
West Branch Farmington River Near New Boston, Ma 183.6 
West Branch Westfield River At Huntington, Ma 192 
Westfield River At Knightville, Ma 122.3 
Westfield River Near Westfield, Ma 930.4 
Connecticut 
Connecticut R At Thompsonville, Ct 16781.4 
Housatonic R At Falls Village,Ct. 1095.2 
Mount Hope R Nr Warrenville, Ct. 49.4 
Quinebaug R At Quinebaug,Ct. 276.2 
West Branch Farmington R At Riverton, Ct. 254.5 
Rhode Island 
Blackstone River At Woonsocket, Ri 778.4 
Branch River At Forestdale, Ri 175.5 
Hunt River Near East Greenwich, Ri 46.5 
South Branch Pawtuxet River At Washington, Ri 130.4 
Woonasquatucket River At Centerdale, Ri 73.2 
New Hampshire 
Ashuelot River At Hinsdale, Nh 687 
Lamprey River Near Newmarket, Nh 283 
New York 
Hoosic River Near Eagle Bridge Ny 958.5 
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Table 4.5 Regulation of streams included in the streamflow database 
Station Name Regulation 

Massachusetts 
Westfield River At Knightville, Ma Flow regulated by Knightville reservoir since 1941. 
North Nashua River Near Leominster, Ma Regulation at low flow by mills upstream. Flow includes diversion to basin for municipal supplies. 
Squannacook River Near West Groton, Ma Occasional regulation at low flow by mill upstream. Regulation greater prior to 1961. 
Nashua River At East Pepperell, Ma Includes water released while diverting flow of Nashua River for use by Boston and from the Ware 

River basin since 1955 for use by Fitchburg. Flow regulated by powerplant immediately upstream. 
Assabet River At Maynard, Ma Occasional diurnal fluctuation at low flow by mills upstream; greater regulation prior to 1969. Since 

1962, high flow affected by retarding reservoirs and, since 1970, occasional release at low flow by these 
reservoirs. 

Nashoba Brook Near Acton, Ma Occasional regulation since 1967 by pond upstream. 
Concord R Below R Meadow Brook, At Lowell, Ma Low flow regulated by mills upstream. Prior to 1961, diversion upstream for use of the city of Lowell. 
Merrimack River Bl Concord River At Lowell, Ma Flow regulated by powerplants, by Franklin Falls Reservoir since 1942, and by Squam, Newfound, 

Winnipesaukee, Winnisquam, and other lakes and reservoirs upstream. 
Shawsheen River Near Wilmington, Ma Diversion upstream at times each year since 1973 for municipal supply of Burlington. 
Parker River At Byfield, Ma Occasional regulation by mill and ponds upstream. 
Ipswich River At South Middleton, Ma Diversions upstream for municipal supply of Reading, Lynn, and Peabody. Occasional regulation by 

mill upstream. 
Ipswich River Near Ipswich, Ma Diversions upstream for municipal supply of Reading, Lynn, Peabody, Danvers, Salem, and Beverly. 

Some regulation by reservoirs upstream. 
Aberjona River At Winchester, Ma Flow affected by diversions for industrial use and for municipal supply of Woburn and Winchester, and 

by wastage and leakage from Winchester North Reservoir. Some regulation by Winchester at dam 
1,800 ft upstream. 

Charles River At Dover, Ma Flow affected by diversions to and from basin for municipal supplies. 
Mother Brook At Dedham, Ma Mother Brook is a diversion from Charles River to Neponset River through Dedham and Hyde Park. 
Charles River At Wellesley, Ma Flow affected by diversion to Mother Brook (station 01104000), and by diversions to and from basin 

for municipal supplies. Occasional regulation at dam 0.2 miles upstream and by other ponds upstream. 
Charles River At Waltham, Ma Flow affected by diversion to Mother Brook (station 01104000), diversions to and from basin for 

municipal supplies, and at times by water released from Stony Brook Reservoir. Prior to 1960, some 
regulation by mills upstream. Low flow completely regulated by Boston Edison Co. powerplant prior 
to 1954. 

Neponset River At Norwood, Ma Flow regulated by mills and reservoirs upstream. Flow affected by several diversions upstream for 
municipal and industrial use. 

East Branch Neponset River At Canton, Ma Flow regulated by Forge, Bolivar, Massapoag, and Reservoir Ponds, and other ponds upstream. Flow 
affected by diversions for municipal supply of Canton and Stoughton. 

Wading River Near Norton, Ma Flow regulated to some extent by Lake Mirimichi and other lakes and reservoirs upstream. Diversion 
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Table 4.5 Regulation of streams included in the streamflow database 
Station Name Regulation 

upstream for municipal supply of Attleboro and small diversions to and from basin for other municipal 
supplies. 

Quinsigamond River At North Grafton, Ma Some regulation by Lake Quinsigamond 2.3 miles upstream and by ponds upstream. 
Little River Near Oxford, Ma Flow regulated by Buffumville Lake since 1958 (Reservoirs in Thames River basin) and by other 

reservoirs upstream. July 1982 to about January 1983, flow affected by draining of Buffum Pond. 
Prior to 1958, flow regulated by mill upstream. 

Millers River Near Winchendon, Ma Flow regulated by powerplant and by Lake Monomonac and other reservoirs upstream. 
Priest Brook Near Winchendon, Ma Prior to 1962, occasional diurnal fluctuation at low flow by mill upstream; prior to 1953, regulation at 

low flow by mill and ponds. 
Millers River At South Royalston, Ma Flow regulated by Lake Manomonac and other reservoirs, by mills and powerplants prior to 1955, and 

at high flow by Birch Hill Reservoir since 1941 (Reservoirs in Connecticut River basin). 
East Branch Tully River Near Athol, Ma Flow regulated by Tully Lake since 1948 (Reservoirs in Connecticut River basin). 
Millers River At Erving, Ma Flow regulated by powerplants and by Lake Monomonac and other reservoirs; high flow regulated by 

Birch Hill Reservoir 22 miles upstream since 1941 and Tully Lake since 1948. Greater regulation by 
powerplants prior to 1966. 

Deerfield River At Charlemont, Ma Flow regulated by Somerset Reservoir, since 1924 by Harriman Reservoir, and by several powerplants 
upstream. 

North River At Shattuckville, Ma Diurnal fluctuation at times caused by mill upstream; because storage capacity is small, daily flows are 
not affected appreciably. Prior to 1950, greater regulation by mill. 

Deerfield River Near West Deerfield, Ma Flow regulated since 1913 by Somerset Reservoir, since 1924 by Harriman Reservoir, and by several 
powerplants upstream. 

Connecticut River At Montague City, Ma Flow regulated by powerplants and by First Connecticut and Second Connecticut Lakes, Lake Francis, 
Moore and Comerford Reservoirs, and other reservoirs, combined usable capacity, about 
43,400,000,000 cubic feet. 

Mill River At Northampton, Ma Flow regulated by mill upstream. 
Ware River Near Barre, Ma Prior to August 1955, slight regulation at low flow at times by Long Pond. Flow regulated by Barre 

Falls Reservoir since 1958. Diversion at times since 1955 from 6.5 square miles upstream of station for 
municipal supply of Fitchburg. 

Ware River At Intake Works Near Barre, Ma Figures of discharge include diversion as needed for Boston metropolitan district during period October 
15 to June 14 of each year and at other times for emergency flood-control purposes as authorized by 
U.S. Army Corps of Engineers; diversion began in March 1931. Flow regulated by Barre Falls 
Reservoir 4.3 miles upstream (see station 01172500) since 1958. Diversion at times since 1955 from 
6.5 square miles upstream for municipal supply of Fitchburg. 

Ware River At Gibbs Crossing, Ma Diversion at times: Since March 1931 from 96.3 square miles for supply of Boston metropolitan 
district and since 1955 from 6.5 square miles for municipal supply of Fitchburg. Flow regulated by 
mills upstream and by Barre Falls Reservoir (see station 01172500) since 1958. 
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Table 4.5 Regulation of streams included in the streamflow database 
Station Name Regulation 

East Branch Swift River Near Hardwick, Ma No flow at times during several years. 
Swift River At West Ware, Ma Flow regulated since August 1939 by Quabbin Reservoir, usable capacity, 53.8 billion cubic feet. 

Diversion from Ware River to Quabbin Reservoir since 1940, from Quabbin Reservoir to Wachusett 
Reservoir since 1941, from Quabbin Reservoir to Chicopee Valley aqueduct since 1950, and from 
Quabbin Reservoir to city of Worcester at times since 1966. 

Quaboag River At West Brimfield, Ma Slight diurnal fluctuation at low flow caused by mill upstream prior to 1956; regulation much greater 
prior to 1938. High flow slightly affected by retarding reservoirs since 1965. 

Chicopee River At Indian Orchard, Ma Diversion since 1941 from 186 square miles in Swift River basin and at times since 1931 from 97 
square miles in Ware River basin for Boston metropolitan district; since 1950, for Chicopee; since 
1952, for South Hadley; at times since 1966 for Worcester; at times since 1955 from 6.5 square miles in 
Ware River basin for Fitchburg. Diversion from Ludlow Reservoir for Springfield and, prior to 1952, 
for Chicopee. Flow regulated by powerplants upstream, by Quabbin Reservoir 21 miles upstream on 
Swift River since 1939, by Barre Falls Reservoir on Ware River since 1958, by Conant Brook Reservoir 
since 1966, and by smaller reservoirs. 

North Nashua River At Fitchburg, Ma Flow regulated by mills and reservoirs upstream. Flow affected by diversions for municipal use. 
Middle B Westfield River At Goss Heights, Ma Some diurnal fluctuation at low flow prior to 1952 caused by mill upstream. Flow regulated by 

Littleville Lake (Reservoirs in Connecticut River basin) since 1965. 
West Branch Westfield River At Huntington, Ma Prior to 1950, some diurnal fluctuation at low flow caused by small mill upstream. 
Westfield River Near Westfield, Ma Flow regulated by Borden Brook Reservoir, Cobble Mountain Reservoir since 1931, Knightville 

Reservoir since 1941, and Littleville Lake since 1965. High flow slightly affected by retarding 
reservoirs since 1963. Diversion fromm Little River for municipal supply of Springfield. 

West Branch Farmington River Near New Boston, Ma Flow regulated by Otis Reservoir 7.0 miles upstream on Fall River. High flow slightly affected by 
retarding reservoirs since 1966. 

East Branch Housatonic River At Coltsville, Ma Flow regulated by powerplants upstream and, since 1949, by Cleveland Brook Reservoir, usable 
capacity, 214,000,000 cubic feet, 5.4 miles upstream; regulation greater prior to 1955. Diversion 
upstream from Cleveland Brook Reservoir for municipal supply of Pittsfield since May 1950. 

Housatonic River Near Great Barrington, Ma Regulation at low flow by powerplants upstream. High flow slightly affected by retarding reservoir 
since 1973. 

Hoosic River At Adams, Ma Diversion upstream for municipal supply of Adams. Some diurnal fluctuation by mill upstream prior to 
1961. Flow regulated by Cheshire Reservoir 5.1 miles upstream. 

North Branch Hoosic River At North Adams, Ma Infrequent diurnal fluctuation at low flow by mill upstream; more frequent fluctuation prior to 1948. 
Hoosic River Near Williamstown, Ma Prior to 1966, slight diurnal fluctuation at low flow caused by mills upstream. Some regulation by 

Cheshire Reservoir 16 miles upstream. 
Green River At Williamstown, Ma Slight diurnal fluctuation at times caused by mill upstream. 
Connecticut 
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Table 4.5 Regulation of streams included in the streamflow database 
Station Name Regulation 

Quinebaug R At Quinebaug,Ct. Flow regulated by East Brimfield and Westville Lakes, and by smaller reservoirs upstream. 
Mount Hope R Nr Warrenville, Ct. Occasional regulation from ponds upstream. 
Connecticut R At Thompsonville, Ct Flow regulated by power plants, by diversion from Chicopee River basin and by First Connecticut and 

Second Connecticut Lakes, Lake Francis, Moore and Comerford Reservoirs, Quabbin Reservoir, and 
other reservoirs, combined usable capacity, about 107 billion cubic feet. 

West Branch Farmington R At Riverton, Ct. Flow regulated by Otis and West Branch Reservoirs and Colebrook River Lake. 
Housatonic R At Falls Village,Ct. Low flow completely regulated by power plant of Connecticut Light and Power Company. High flow 

is regulated by flood-control reservoirs from 20.5 square miles in the Blackberry River basin, but does 
not affect monthly runoff appreciably. 

Rhode Island 
Woonasquatucket River At Centerdale, Ri Some regulation by reservoirs upstream; regulation greater prior to 1956. Discharge figures prior to 

1966 included leakage around station through bypass canal; leakage negligible subsequently. 
Blackstone River At Woonsocket, Ri Flow regulated by powerplants, by West Hill Reservoir since May 1961, and by other reservoirs 

upstream. Extremes and figures of daily discharge include flow diverted from Nashua River basin and, 
at times since January 1966, from Quabbin Reservoir for supply of Worcester, MA, and, prior to July 
1964, flow diverted around station in Hamlet Trench. 

Branch River At Forestdale, Ri Occasional regulation by pond upstream. Prior to 1957, greater regulation by mills and reservoirs 
upstream. 

South Branch Pawtuxet River At Washington, Ri Flow regulated by Flat River Reservoir 2 miles upstream, usable capacity, 250,000,000 cubic feet, and 
smaller reservoirs. Prior to May 1972, diversion from Carr Pond for municipal supply of Coventry, 
Warwick, and West Warwick. 

Hunt River Near East Greenwich, Ri Flow affected by diversions for supply of East Greenwich, North Kingstown, Warwick, and Quonset 
Point (formerly U.S. Naval establishments). 

New Hampshire 
Lamprey River Near Newmarket, Nh Some regulation by Pawtuckaway and Mendums Ponds. These reservoirs have a usable capacity of 

about 600,000,000 cubic feet. 
Ashuelot River At Hinsdale, Nh Flow regulated by Surry Mountain Lake 33 miles upstream since 1942 and by Otter Brook Lake 29 

miles upstream on Otter Brook since 1958 (Reservoirs in Connecticut River basin). Diurnal fluctuation 
by mills upstream. 

New York 
Hoosic River Near Eagle Bridge Ny Diurnal fluctuation at medium and low flow caused by powerplants upstream from station. 

4-15
 



5 References 
DEP (Massachusetts Department of Environmental Protection) (1996). Estimating the Firm 

Yield of a Surface Water Reservoir Supply System in Massachusetts: A Guidance 
Document. Water Management Program, Office of Watershed Management. January 
1996. 

DEP (Massachusetts Department of Environmental Protection) (2000). Personal communication 
- Duane LeVangie, Bureau of Resource Protection. 

NOAA (National Oceanic and Atmospheric Administration) (1995a). Cooperative Summary of 
the Day: TD3200 —  Period of record through 1993: Volume 16: Connecticut, Maine, 
Massachusetts, New Hampshire, Rhode Island, Vermont CDROM. June 1995. 

NOAA (National Oceanic and Atmospheric Administration) (1995b). Cooperative Summary of 
the Day: TD3200 —  Period of record through 1993: Volume 17: New York, 
Pennsylvania CDROM. June 1995. 

USGS (United States Geological Survey) (1991). Water Resources Data Massachusetts and 
Rhode Island Water Year 1990. U.S. Geological Survey Water Resources Division. 
USGS-WDR-MA-RI-90-1. March 1991. 

USGS (United States Geological Survey) (1992). Water Resources Data New Hampshire and 
Vermont Water Year 1991. U.S. Geological Survey Water Resources Division. USGS­
WRD-NH-VT-91-1. April 1992. 

USGS (United States Geological Survey) (1993). Water Resources Data New York Water Year 
1992: Volume 1. Eastern New York excluding Long Island. U.S. Geological Survey 
Water Resources Division. USGS-WDR-NY-92-1. 

USGS (United States Geological Survey) (1998). Water Resources Data Massachusetts and 
Rhode Island Water Year 1997. U.S. Geological Survey Water Resources Division. 
USGS-WDR-MA-RI-97-1. May 1998. 

USGS (United States Geological Survey) (1999). Water Resources website - water.usgs.gov. 

5-1
 



             
             
             
              
              
              
              
              
              
              
              
              
              
             
              
              
              
              
             
              
              
              
              
              
              
             
             
              
              
              
              

Appendix A Sample meteorological data file 
The following is a sample meteorological data file showing the beginning of the file and the first 
six years of meteorological data for Boston’s Logan International Airport. 

888 
190770 
BOSTON/LOGAN INT'L ARPT
 4.23666666666667E+0001
 7.10333333333333E+0001
 1 1920 29.5 12.5 24.8 2.72
 2 1920 34.6 20.6 32.5 4.11
 3 1920 48.0 30.5 11.0 3.72
 4 1920 52.1 38.0 2.0 5.68
 5 1920 61.8 47.5 0.0 5.26
 6 1920 74.1 57.6 0.0 5.78
 7 1920 81.4 63.4 0.0 1.56
 8 1920 78.9 65.2 0.0 2.32
 9 1920 72.9 57.6 0.0 1.90 
10 1920 68.5 51.0 0.0 1.64 
11 1920 48.4 35.0 1.8 5.46 
12 1920 41.7 29.5 5.5 3.89
 1 1921 41.5 25.8 1.6 1.80
 2 1921 39.6 25.5 23.2 2.64
 3 1921 55.8 36.7 0.0 1.92
 4 1921 59.5 44.0 0.0 4.62
 5 1921 66.1 50.0 0.0 3.63
 6 1921 77.1 59.3 0.0 3.58
 7 1921 80.3 66.2 0.0 11.69
 8 1921 77.7 61.5 0.0 1.63
 9 1921 76.9 60.1 0.0 1.22 
10 1921 63.8 46.6 0.0 1.24 
11 1921 47.7 35.4 5.7 6.19 
12 1921 38.5 24.1 4.4 2.38
 1 1922 34.1 20.3 2.7 1.41
 2 1922 39.8 24.3 15.5 2.64
 3 1922 47.8 31.8 10.1 4.30
 4 1922 57.7 39.7 3.3 2.48
 5 1922 70.9 52.0 0.0 5.34
 6 1922 76.5 60.8 0.0 8.05
 7 1922 79.7 64.4 0.0 2.63 
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 8 1922 77.4 63.4 0.0 4.75
 9 1922 73.2 57.1 0.0 3.65 
10 1922 63.9 46.3 0.0 1.97 
11 1922 50.1 37.4 0.9 0.84 
12 1922 37.3 24.5 14.7 3.01
 1 1923 34.4 19.5 25.3 6.07
 2 1923 30.5 16.7 14.4 1.48
 3 1923 42.5 25.2 10.6 2.49
 4 1923 57.9 38.4 0.0 5.26
 5 1923 66.5 48.6 0.0 0.83
 6 1923 79.0 59.6 0.0 2.03
 7 1923 77.7 62.2 0.0 3.36
 8 1923 78.1 60.5 0.0 2.07
 9 1923 71.6 57.1 0.0 0.38 
10 1923 63.6 47.5 0.0 3.37 
11 1923 51.5 37.8 0.0 2.59 
12 1923 46.6 34.3 3.0 4.99
 1 1924 40.5 23.3 8.5 3.27
 2 1924 33.7 19.8 10.4 2.61
 3 1924 44.3 31.6 7.4 2.04
 4 1924 54.9 39.6 3.0 3.79
 5 1924 63.6 48.8 0.0 2.81
 6 1924 75.1 58.2 0.0 1.07
 7 1924 82.9 64.8 0.0 2.04
 8 1924 79.5 64.4 0.0 6.86
 9 1924 70.0 54.4 0.0 6.96 
10 1924 63.3 45.9 0.0 0.06 
11 1924 52.7 37.1 0.5 1.93 
12 1924 38.8 23.4 0.2 1.48
 1 1925 34.9 19.4 20.7 3.97
 2 1925 45.3 30.8 0.0 1.55
 3 1925 51.5 34.6 0.0 5.21
 4 1925 58.1 41.1 0.0 2.48
 5 1925 66.5 48.4 0.0 2.57
 6 1925 80.7 61.1 0.0 4.59
 7 1925 80.5 64.1 0.0 3.54
 8 1925 80.0 62.3 0.0 1.40
 9 1925 72.1 56.0 0.0 3.45 
10 1925 57.0 41.9 0.0 4.03 
11 1925 51.3 36.0 0.0 4.16 
12 1925 39.5 27.7 0.5 5.20 

A-2




     

Appendix B Sample USGS streamflow file 
This is a sample USGS streamflow data file showing the beginning of the file and the first 
several weeks of streamflow data for the Shawsheen River new Wilmington, Massachusetts. 

# US GEOLOGICAL SURVEY 
# DAILY MEAN DISCHARGE DATA 
# 
# Station name : Shawsheen River Near Wilmington, Ma 
# Station number: 01100600 
# latitude (ddmmss)............................. 423405 
# longitude (dddmmss)........................... 0711255 
# state code.................................... 25 
# county........................................ Middlesex 
# hydrologic unit code.......................... 01070002 
# basin name.................................... Merrimack 
# drainage area (square miles).................. 36.5 
# contributing drainage area (square miles)..... 36.5 
# gage datum (feet above NGVD).................. 80.44 
# base discharge (cubic ft/sec)................. 300 
# WATSTORE parameter code....................... 00060 
# WATSTORE statistic code....................... 00003 
# Discharge is listed in the table in cubic feet per second. 
# 
# Daily mean discharge data were retrieved from the 
# National Water Information System files called ADAPS. 
# 
# Format of table is as follows. 
# Lines starting with the # character are comment lines describing the data 
# included in this file. The next line is a row of tab-delimited column 
# names that are Date and Discharge. The next line is a row of tab-delimited 
# data type codes that describe a 10-character-wide date (10d) and an 
# 8-character-wide numeric value for discharge (8n).  All following lines are 
# rows of tab-delimited data values of date (year.month.day) and discharge. 
# 
# NOTE this file was requested from the NWIS-W software package 
# on Mon Sep 21 15:30:25 1998 
# Dates are now in format. 
# 
# ----Date Range In File---­
# 1 11/21/1963-09/30/1996 
Date Discharge Flags 
10s 8n 2s 
11/21/1963 35 0 
11/22/1963 34 0 
11/23/1963 33 0 
11/24/1963 42 0 
11/25/1963 54 0 
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11/26/1963 59 0 
11/27/1963 54 0 
11/28/1963 46 0 
11/29/1963 43 0 
11/30/1963 96 0 
12/01/1963 231 0 
12/02/1963 202 0 
12/03/1963 145 0 
12/04/1963 108 0 
12/05/1963 87 0 
12/06/1963 74 0 
12/07/1963 65 0 
12/08/1963 58 0 
12/09/1963 62 0 
12/10/1963 94 0 
12/11/1963 120 0 
12/12/1963 103 0 
12/13/1963 83 0 
12/14/1963 72 0 
12/15/1963 60 0 
12/16/1963 49 0 
12/17/1963 43 0 
12/18/1963 37 0 
12/19/1963 35 0 
12/20/1963 33 0 
12/21/1963 31 0 
12/22/1963 29 0 
12/23/1963 28 0 
12/24/1963 27 0 
12/25/1963 28 0 
12/26/1963 30 0 
12/27/1963 31 0 
12/28/1963 29 0 
12/29/1963 27 0 
12/30/1963 25 0 
12/31/1963 24 0 
01/01/1964 22 0 
01/02/1964 26 0 
01/03/1964 28 0 
01/04/1964 31 0 
01/05/1964 33 0 
01/06/1964 34 0 
01/07/1964 36 0 
01/08/1964 38 0 
01/09/1964 38 0 
01/10/1964 41 0 
01/11/1964 45 0 
01/12/1964 43 0 
01/13/1964 40 0 
01/14/1964 33 0 
01/15/1964 30 0 
01/16/1964 30 0 
01/17/1964 29 0 
01/18/1964 29 0 
01/19/1964 27 0 
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Appendix C Sample reservoir summary file 
This is a sample of a summary file produced by the FYE when the Summary file option is 
selected from the File menu. 

Firm Yield Estimator Summary File
 
Title:
 
Atkins Reservoir - Amherst, Massachusetts
 
Comments:
 
This analysis assumes a constant surface area for the reservoir
 
of 0.063 square miles.
 

Meteorological Data
 
AMHERST
 
Latitude: 42.3833
 
Longitude: 72.5333
 
Period of record: 1926 to 1993
 

Streamflow Data
 
Mill River At Northampton, Ma
 
Latitude: 42.3181
 
Longitude: 72.6558
 
Period of record: 1938 to 1996
 

Missing meteorological data were replaced with average monthly
 
values.
 
The meteorological station is approximately 7.7 miles from the
 
streamgauge.
 

Reservoir Data
 
Area of the reservoir watershed: 5.85 square miles
 
Area of the streamgauge watershed:  54.0 square miles
 
Reservoir capacity: 1000 million gallons
 
Required releases: 18.6 million gallons per month
 

Bathymetry Data
 
Order of the polynomial used to characterize bathymetry:  0
 
Constant coefficient : 0.063
 

Peak Use Factors
 
January : 1.08
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February : 1.03 
March : 1.20 
April : 1.15 
May : 1.19 
June : 1.10 
July : 1.19 
August : 1.13 
September: 0.85 
October : 0.56 
November : 0.54 
December : 0.99 

Evaporation Rate Data (in inches per month) 
Evaporation rates were estimated from meteorological data. 
Reservoir longitude: 72.484 
Reservoir elevation: 470 feet 
January : 1.00 
February : 1.38 
March : 2.52 
April : 3.88 
May : 5.65 
June : 6.60 
July : 6.98 
August : 6.01 
September: 4.19 
October : 2.65 
November : 1.43 
December : 0.97 

Withdrawals by Other Users 
January : 0 
February : 0 
March : 0 
April : 0 
May : 0 
June : 0 
July : 0 
August : 0 
September: 0 
October : 0 
November : 0 
December : 0 

Input Data for the Streamgauge Transform 
Average watershed elevation: 850 feet 
Mean channel slope: 182 feet per mile 
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Maximum soil retention: 6.39 inches
 
Average annual precipitation: Calculated from meteorological
 
data
 
Average annual snowfall: Calculated from meteorological data
 
Generating 1,000 Year Sequence of Meteorological Data
 
The entire period of record was used to generate the 1,000 year
 
sequence of meteorological data.
 

Actual meteorological data were used in the firm yield analysis.
 
Data between the years 1939 and 1993 were used in the analysis.
 

The scanning yield of the reservoir is 3.188 million gallons per
 
day.
 
The reservoir did not refill during 3.7% of the years in the
 
scanning analysis.
 
The firm yield of the reservoir is 3.322 million gallons per
 
day.
 
The reservoir did not refill during 3.7% of the years in the
 
firm yield analysis.
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